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Test Grenup: Edton *
Here: Detaul Test Grewp
Spider fyitess | 5vE 1586528 Input channeld Shaker paramaian.
Aaasacson] [ Asasess | [ ien | | memese | Mo | [ Meveup | [Movecenn| [ cme
Section | Siatus Test Last run Last run time.
P
Doee S Freweren Bunt 2 meeates age
Done (R Bun2 Ominteage 00
Mot done 85 - Xoawie Dot Feier e
het done. e - Post-yeeen Default Folcer Na
Yz
et dane e - Ermaguetgy Run? 2 mites age
et done Rangge - V.aus Defauit Folger Na
Hat done SRS - ¥-ais Detauls Folger HA
Hot dame Sirue « Bonzzmerp ifault Foidser A
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Het done St - Pre-aiveen Bun! 2 minutes sge
Moz dane Randers - 3-gam Ha
Not dong SRS - T.gwe Na
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o FXIANFIR BENARC R, RS B F A
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Signal Selection - (SIGO005_APS(Ch1))

Channel signals (1) Other signals
s

® Saved signals VAl

/' Live signals

Search signals...

4[] |88 Signals

1A, SIG000S_HighAbortif)
- [F1 Jaw, SIG000S_HighAlarme)
-0 JA, SIGD00S_LowAbort(d
1 Ia, SIGO00S_LowAlarmif
- [ a, SIGD005_controlf

i [, SIG0005_profile(f

i~ [0 [, SIG000S_noiseif)
[ [Aw, SIG000S_APS(drive)

Un-zoom All

Add Curser/Marker

X/Y Scale

X Axis Format

V Axis Format

Spectrum Type

2nd Spectrum Type
Acc/Vel/Displ

Weighting Type
Add/Remove Signal
Remove Signals from Display
Add All Signals
Report/Export Window
Duplicate Display Settings
View As..

RMS/Peak Values on Chart
Plot Settings

[ e

Signal Selection - (SIG0005_APS{Ch1))

Channel signals (1) Other signals

=i Live signals ® Saved signals

Search signals...

x
s

_ All signals

[x

4[] 8 Signals
b (0] Jio, HighAbort(f)
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E
il aeny BuOnA D =
- Daatoeg revatty
Compotte Sigley
Active pgnal window Active ta
— Agtive ety A sigel misim
A siged window Channel siatr
Channel statun AneCtEons and aachmens
o et
4 By inforrnation Runiog
~ Bun lng Tesk configuestion
+- Te eenfigeatin et paeareters
Tew pacamaneny Channel tabie report
#= Channel table repant Frofile
- Profile Fun whedule
Fun schedule 5| Check sgaingt shaker btz
+~ Check agenst shaker bty Lurret channiels.
= et channsle S Lbeary
Lo Lraey Toct ctack lst
Test check st Sgides vptem setbing
e St pyttem e Channel caisrason
Channel cabbraacn Sensor bt
— Sever fat Smter spster eenfiy
Sgicer gpetim £anty FOM sotpaare
- (58 sptomee Lcene ey
— Licerie ey Erpreenng und semngs
Ciatabune sethingy
Aseount permission

o DR AL, AP EHIREIINE .
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o Ol AR RGZISAT H SR B DIRE, AT DL AN v 4R
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o BEMSIR TS LLAT B4R 5 A HC L

o RENBR T PIRISAT ORATHOAE 5 A TE B

o FTHZAIE R K.
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10.1 & below 11.0+

Freeze Display Crls)
X/¥ Scale *
Add Cursor/Marker »
Add Cursor/Marker *
. Remove Cursor/Marker »
v Copy Cursor/Marker Values ¥
g v ] Display Cursor Values
Remave All Signals XY Scale *
Add AllSigrals i .
sl i X Axis Format »
— Y Axis Format »
Copy
Save Bitmap Spectrum Type »
Acc/Vel/Disp! »
Weighting Type »

Add/Remove Signal

Remove Signals from Display
Add All Signals

Legend Report/Export Window 3

icate Display 5
RMSPeak Values on Chart Duplicate Display Settings L]

Export displayed portion of sigrsls View As.. »

Prirt this Wirdow RMS/Peak Values on Chart L

Report this Wirdow = ¥ Plot Sestings

Refreshdata to B

Customize Nt

Flot Proparties

feRasbn e A

TR B HE A — BT IVEDMB. FIRE S, B TEACHE AT A% 18 o
B E—ANEIREE . — MBI — AN S5 R S X T T 55
AT FEVE I RN E BOIRSI E AR, AR5 R AR A A A
HZBARERHEAT IO . AR5 T DURH B3t A S AR Y R B, DA
BRI R BT R TG R RS 5 . R ZESpi der A 3CHF, 313
B R RE RS

TCS

td

EDM-Transducer
Calibration

Plear select the calbration type

<;’ Transducer Calimate the g & Kk calit st The e 2 with
Cabbration 159001 aned 150 17825,

| =
E —_— 'JI UUT Sensor
| —
A h Reference Sensor
Ethernet

|| spider-818

Shaker
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Enter the customer name and the sensor name

Customername:  DEMO001 [5] /= Skip

Sersor name Drytran_3263Ademe = Skip

Fillim the banis information foe this eyt
Mote: you wil be abie 10 search Tor ths best by Test Name' or Test Desoiption”

Craste dnem Toane duter Cabkeation tests DEFGOO1_Dytran_3263Adenms 7

Frest name DOM000 1 Dyran_YeMdena_ # Append the sequence numbes 7

Test descrippon:

) Use the detault iwies. of the presioun best of the same type. If detalt oaries were not applied befone the msmulcturing setings mill be wred.

o JHIEFIRBEMAME, 5HrAEDMNH—E

gt Charnets fox DEMIBNEH Dytan 3053hdema 6 [1C5Aee] T ox
8 By | | gl tange  Seve as detiun ¥ duoidioceen an
[Z— Uas,emice High-pass
- Semtasty gt mode Somier e st

| 15070088 g

Jere  Jitoer Dot~ JonmoongJoscee
i [WPL B e P )
P i = |Uher Dafim ose |

o BilEB%
o Wl RBUTRE
o R IR SRy v ] DA 2538 TE % R IE 3%

Test configuration
Sampling rate (Hz): Default [+
Drive limit (V): 1
Sine dwell time (s): §
Reverse polarity:
Caliib. sensitivity: v
Reference freq.(Hz): 100
Reference level (g): 1
Calib. freq. response: 7
Calib. method: Step Sine [<]
Point list:

_

o U FINIE SEFREI e B H AR 1

& Tout Condiquranioes for DEMOXON Dytran_3263Ademe &

Vo proflle - Swept Siow = || A m—ﬁ.

w00

Iraertri [Deletn row [2pgend rms| | Cieartable |0 - i Logha

Frequency Accelenstion Weloety  Dmplacesnent
H ] e ek gk | TRt fype




o YA I SLFREIIR T B 4R : e
_ Live Signals ”Run Folders | Data Files‘
| Bt st -Stappad Sine. & | isswstven] [Dubsturow [Appwd rouw| Import/Export st ~| - ‘G Run10 Jan 19,2023 11-19-35
Snaker parameters Frequency () Accelesstion (9 [ SIGO010 Jan 19, 2023 11-23-41
bt B i [+ TimeHistory0042 Jan 19,2023 11-19-56
File directory e 1 [ Mt SIGD00Y Jan 19, 2023 11-19-50
S == :go : I % TimeHistory0041 Jan 19,2023 11-19-35
e : [ w3 Run9 Jan 19,2023 11-19-06
s o j [ w3 Rung Jan 19,2023 11-18-17
I e : [ w3 Run7 Jan17,2023 15-04-50
| I i [ w3 Run6 Jan 17,2023 14-07-20
| [ w3 RunS Jan 17,2023 14-06-14
I« Rund Jan 17,2023 14-05-40
[ %3 Run3 Jan 17,2023 14-00-41
— I« Run2 Jan17, 2023 14-00-21
2 f__// [ w3 Run1 Jan 16,2023 11-33-20
- - «4 Default Folder Jan 16,2023 11-32-06
i S —
¥ ‘ SRR i
el | = . HERHUE
— MR Ih AL

o ZUGATE, AR AT DU %R ] R A A A E HARRIR R DI HTIE T TR R st v AR 7 ZE R B .

| Btm i } mEAh '—
|Recer1t tests o |
i YE o &R [| o =5 A4 B4
Mew Open Properties Delete :
4 = DEMOO001_Dytran_3263Ademo 6 = = ar =
S e o swmE beasEmn || L ER: 2545
S E L (i T (EH): 3,545
|- iZ MO6758 Dytran_3263AS _ LRfDraEmant o . 2712
[~ i= MO6758_Dytran_3263A 4 v RETiE, FesER = (EH): 1.;_7_:'%‘
_.[r* i= MOG755_Dytran_32634 _ TERHRES (cm) : 1.2?.%]
I+ = MO6751_Dytran_3263A : R
" L2 SREE/RMS EEAHE/RMS waE BEHIEE
BB ReHE
AT, A VRIEAT AT DU Rl — BB R A R ot IR EERE fEEPkPI
o ZiBiTE B[RRI AT ] LLET R [R]— 245 B AN [l % — o e
M8 SamE ¢ LT v Bas v S v S
v 5m LEBRNTEY SR
EHESE BRI HEE BEE BigE IR RS
SHEE BAuE
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o WATRAER W E AT MR

—
Statu:  Level W Conbicl pealt/BMS o Target peak/AME (0 Deive Dl
AVD: @ heceleation Pk 1@ Velocity PE ¥ Dusplacemners PL-P
Testing time: & Towl elapsed ¥ Full evelelapsed @ Remsining fimedpul & Run stact fime Dats messured at
Test parameten: i Content stmtegy ¥ Lines # DOF ¥ Averags ¥ Cverlp ratic.
9 0etar ¥ Frecuencynge 4 Sqmasipping
Shaker parsmesers: 4 Baylosd mass % Force pesic “ Min frequency L 3 o peaiciR,
 Max vebocity & Max daglacement

o TR I LR Sh R MR R U LA AT DU T 7ERUE/ B G
AR .

—[BFA | L E) —

HE emm || e®mE A m
| AR | - | e
[ = L (EF): 2542 EUBEAT B =4E5
&= ) - PR, SRR S B R R, FEHE M5
| RS T EERTRALL = > I (2555 T A3 AT
T (ER: 127
O RERRE, FOREA || & @) = E
TEIRHIES (cm) : T.EYE

o Oy T REF—BUE, T LA B bRaE”

Navigation o7 £
o, AllTabs

Voadegs  Pugu Ao

Lvad Eamats daring Bn
Cartinl Campoiee
et Sgrad Windhow ]
pre
e
Chanral ftata

[
L

P Cham sk
TutngPrstie
B St

BN Rty

Vmit Chanrls
thates Pursemetany
Chack it

et e L T T
R e T e e e

{58 SR SR

HARE OEH N BRIETRF o WEAE AR T W /KT -
ent - VCS Enterprise o [RBBLR RAR IR, DUE BEIE M R G S .
Layout| Tools Report Help o BLE PR /NG R AN IR NI ALK
| + New Tab L4 New Tab Ctrl+Shift+A ——
= CloseTab k Time Streams i T sE ROk L] [+]
|+ Import Tabs (Add) Ctrl+Shift+0 Statistics Time History fERg: VEEEOE [+] REEFaLEs
¢ Import Tabs (Override) Time Blocks 7| BESTCTEERR EER|NAREFRH): 10.005
i FHEEESERENEEINT R NEEH: 002
®  Export Tabs Ctrl+Shift+S Auto-power Spectra (APS) | e 2 5002
| [ Dock All Windows e s

Tab Layout Setup

Live signals | @ Saved signals: |5iG0645

o) Stack plot @ One signal per plot (——-—_

IColumn number:
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o WA IHR AT LR INE 2

| vraoomal i wmRL | TRO #=R WHH
[Wﬁ'-_” Vertical Cursor ¥ 1 ooE08 | I * iz » E
Remove Cursor/Marker L Peak Cursor i 07 »
Copy Cursor/Marker Val
i il Y | | 8 1. aFaEEE cw-shin-0 |
XY Scale 3 Valley Markers - rerrrrrerrs erEa | =
X Ais Format 5 [ o Mk | Ealepa e ke sl rete of e v e B B
¥ Axis Format » Customized Matkers | et e s FE=mE Qutshitss K
St Ty v | | AddAnnotation |~ Erxanore ' B
| mssanE0 E
|2 =amra=0
| ===0
HESREN
FREETED
SEHEET l:
o 2EEm Ctrl+Shift+F
L1

o V(R AT AR EZ N2 T D AR S).

B S om0

Hry et e

IMb 1 .;a“n m_‘ 7 -h
Priioe 01 s 124%

BEE Dy

Horzeenal Curtar Vet
Frequency SIGO644 APSIChOT) ¥ LogMag o / X Frequency | Rumiilan1®,202310-03-45 SIGOG1Z APSIChD1) ¥ LogMag o°
He {He) H
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Tanias T2 ooz ey i n
90148 wits noes - -
ap1a1 aazs [noiza SR
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o Test Configurations for Randomad [Random]

File directoey || un toder optived

Shaker parameters d

Test directony:
i i e & ol Toldne dvmery vim (3 Lo v s Sl fr vy o

#re-test parametens

Secpuence rmber stay froem

Sequence rumber wtarts froen e

Mote: Becced file and sime hissory file use the same

e TimeH
i history file rame prefic. TimeHicteey SqUnce mimbar

Witsmn dbmchcled entry ttait

& When vt abets

¥ Wihen cestpases 21 igeal windows
¥ When bt is Smiched Sofeware screenshot

ey ol s

Erabie a tiner mhen sehedule sty

PG I B LR R R AE S R ZRTER
MG IR R 2205 S A SRRSO el = A

|Mergesatting! | Set specteum femat |

Sagnad Swdaction - (APHERIT] * | | SAPECh .

| Destination for raw teme stream signals | Fazerd iz Front-Eng wemal g | *

HN SR BRI, SRR EREAR
HEN I W BB YIS, BUT BoR B B R AL
R [ B 8 2 T LA ARG I 80 A A [ B4 5 R R OR B

Spider Check List
° 7J(q2$ﬁﬁé|]§§ :j(%ZﬂE E(] 7@ . *%fﬁﬂ Eﬁf‘gﬁé z_ﬂ Pleass confirm the following critical parsmeters for this tect:
Profile Schedule test
° EE$E E{] —{E @ jF[I %ﬁ Item | Parameter
P”“_I Shaker name
o IR 200000 Hz :z:::taiczss
Level 100.00% duration 00:0500 Mo i el
° m%{a *ﬂ?la Total test duration
Drive limit
- - — e Sigma <l
o TR UBEHTRITE RO e
Pre-test Input channels
o A i tem Parameter Location ID | Parameter
® 57 E E"]ZK lg%)ﬁ@ ~ ?ﬁi Pre-test mode Aun pre-test with confirmation Ch1(Q) 100.0000 (mV/q), AC-Single End
o . Initial drive 0.005V ch2 100,000 [mV/g), AC-Single End
o ORI ARRAERIET R 4 Response level goal 10%

Maximum drive o7V

EDM 3Rzh¥ &) estdirector: | CAUsers\KevinChenghDocuments\EDMyimportapssignals?\Random30
X B R RAF AL B R E e e AP =
TEEDMIURIC & & B0 S0k H e iR, A0 IR SO RUZ AT SO A

DLE I T . F AT U IR S AR AE B bR I SR e, R e

A SR BRI S 3

Check list

Show this windew and wait fer user cenfirmatit D |“"‘“’@R""‘““-, |“‘"@B€ﬁ—“
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Test Properties Masiured Signals Setup

Time streams Sentones fome hevtcry Tome Biocks | Aute-powes Senctin (4551 o specta. Omboar 6 eer P bracgommey hepes P Math sigeuts | Hish
e, Random30 hnete
# Mewture o sty Save a8 vgnatt | e | Detete 8 vgnain
nerire Save et Wiw Operan! | Delete | £t Save destination
P > o =] 2 APHORL X @ &
Description: o = a B A ¥ 10
03 2 =] L | APHICKS) X 9
ook =] =] [ | AP x o e
008 B =] u wucn X O R
o0 =] = L | APSCH X O
o ) ] [ | ] X O e
%8 =] =] [ | APSICHS) X & x
_

I Detail information I

Created at: 1/17/2023 2:45:03 PM

Medified at: 1/17/2023 2:45:50 PM

Last run time: 1/17/2023 2:45:23 PM

Spider system: SYS_2590976

Created version: 111.0.0.0

Last run version: 11.0.0.0

wBun foldecootions
estdirectory:  C\Users\KevinCheng\Documents\EDM\importapssignals2iRa ndorr1 Choog]

® Create a new folder every run (2 Use the same folder for every run

un folder name: Run Sequence number starts from: gE

[l Lock test W| |T| | .

155 B0 PR3l FH AU
SR

I Run folder options I

Testdirectony:  CH\Users\KevinCheng'\Documents\EDM\sqlite3\FFT32 i
| Measured Signals Setup

Create a new folder every run (@ Use the same folder for every run

Time streams iiStatist\'cs time history iiTl’mE bIDcks’%}AutD—power Spectra (AP S):' Error spectra iiDm—board Frequency|
Run folder name: Run| Sequence number starts from: — '

| All signals |

Save/Recording

Signal name Measure Save/Record list Signal color e
I | Ch1 | FLASH
KEFPCHZAE S XA A K BAL G SR RIEEH I |cr2 FLASH
FEEDMBA: A A STREXT AN IR B K85 SRR LIS S, E:‘: Eﬁz:
PSR, 3 0% ! [ e

Ch7
Ch8

FLASH
FLASH
| FLASH

o TR —

drive
Block(Ch1)
Block(Ch2)
Block(Chd)
| Blockichs)
| Blockichs)
| | BlockchT)
& | Block(Chg)

HEEREERRA

EEEEEEECEEEEEEN

o creste @ new signal For example, to compute the difference besween channell and channel2. sefect Operand? zch1
and CperatoreMings.

Sgnal lut | [ Sagnal = Cpesand] [Cperater) Cpevand? |
Sigraal Name APSICREVAPSTRS)
Gpecandl Opaator | Openand | Signal Selection - Control Compaosite *
st Constant Use Constant
Channel signals Tolerance
APS{ChE) - - APSICHS) =

® Live signals Saved signals All signals

Search signals...

- [ 8 Signals S
-2 [t HighAbort) (M »| [m=m <|

| H | - @] Jhw, LowAbort(f) |§| |E|
| i B oot (]
..... 2 = B JAw, APS(drive)
| : . ] [, control(f) |E| |E|
| [ [, profile(f) |§| |5

]-’_u. noiseff)

R ER|ERfEN

ElE
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IETZERERIEN : AP AR PR R IR 2%
HhZE I ER ERIE WS TRt A A LR G B T i

Advanced Settings

4 Send digital output when select limits are triggered
Raw time limits
RMS time limits
Frequency domain Abort limits{excluding control channeis)
¥ Using heterodyne modulation tracking filter {if not checked, use FFT-based tracking filter)

Note: Heterodyne tracking filter has the fastest response time.

Drgital output channel: | Cutput 1 |L!

Signal pattern: '® High Low H-L-H L-H-4L

2| Record signals when selected limits are triggered

Pre-record duration (s)

Record duration (s)

SoRRoRHj##
SoR & RoR H#Axi [A1HT & [A] )5 1441

TR i J " HE R SC T ARG N Y SORFIROR A A o

¢ Test Configurations for SORROR3 [Random on Random and Sine on Random]

RoR profile % || Random nar band b

Shaker parameters Current narrowband

Test parameters [l Sweep in harmenic mede

Pre-test parameters

g Test Configurations for SORROR3 [Random on Random and Sine on Random]

SoR profile % || Tone number

Shaker parameters Eyenent fome |T| : E |?‘
Test parameters o o

] Si h i d
Pre-test parameters PR R

Test profile Property of tone 8

RMS limits o dror e
1| Use advanced profile E ofile

Run schedule E il |

Limit channels Peak (g) TE

Event acticns High-Alarm (dB} S.DUE Low-Alarm (d8)
RoR prefile T slmE B
SoR profile

Sine/RSTD/Multi-sinen§tid
EDMERAL) ™32 [P RAE BRI, B vy IR i KB, S AR ATk H A
e B NIER (1) 2.27 1

mmes ? =

PERIRE:
1.000[]| [ocmin (5]

FRIC TSR (dB/s):
202

FFBMISO 1A,

R
v REREAT| |

s ———
T
THOIHEY
AR

Cmme | BMO |

o Sinefl TS FFITFRREHL MK

4| Signal plot poinss: s

Single charinel
sl drive (Vs

Deive vt (Vo Py

See trpe: Legasitnme

@ pretest

Messirement rategy: itee = Fioreinio”

ok
" 0 1920 008

s o | Dot o ppon row || G b |1 - | {iwporynatyee = | Eipont =] ¥ aui{Loghag (=
|+ 0 10 ]
‘jl 2 a0 2713608 [ ]
| Fee— ——
i 3 350 2TI3E-08 ==
?.-_ 4 0 ATIISET _

o FHZHTORAT ) e 338 pR KU IE 52 T PR

e et Wieaed

[rp——
Tt ol e e 1t e defaut e

Vibration Control (VCS)

Sl e voaired ful werrion Sine Comtrod
Sanrah: §
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e laat saved sgnal hle

Ligting §




Shockifi#
ERSBER A ZRMS,

IR RE

ARSI FRMS T 21 -

Level (3t): Drive Pk (V):

100.0]  0.5039)

Control peak (g): Target peak (g):

5.0229 5.0000

Total energy: Level error (36):

1144.3062) ___ 0.46

MNext level (3t} Next drive Pk (\V):

s —

TWREG#H
TWR MK A bR S (A E A0 )

FOFARE T TWRI BRI G E AR i B, DR AL S — B

AP B

Sgnul gepest:s Gansel proseni

Text layout setting

Oniy eipan ¥ values

D block signal to Time Siream}

L# Sare signais by tignal 10

Separate Sme and frequency fles

# Amange tables horizontally
Stack tbles vertisly
bses setting

For €5% and TXT files with multiphe tables:

*SG001, S3004.000)

[z o RECOD78_PA12 1/19/|

Export
wn RECO078_PATT 1/19, nd
14 RECOO7S_PA10 1/19 R
Rename

it RECOOT78_PAD 1/19/:

Cpen File Location
fant RECOOT78_PA7 1/19/:

[
[
[+ 4 RECOO7S_PAS 1/19/:
l
[

«

Expand All
4t RECOO7B_PAG 1/19/: it
5 [} 1410 RECOOT8_PAS 1/19/. btz
1§ 1 RECODT8_PA4 1/19/ Signal Details

i Tiene Blocks
s BlockiChTEn
BloekiChi]

Bleckitn3|
¢ BlockiChd]
x BlockiChs]
BloekiChal
B BlockiChTl
4 Blockichil
£, BlockiChal
4 BlockiCh1l
= BleckiCh |
124 Block{ER1]

ra | Crystal instrmants FOM softwars Wer.11.0.0.0
Instrmer Uninown
Test Note NWHTest 1182058

Dta Acqu 17152023 L0947 P
Signal Exp 1/19/2005 2:02:34 M
User:  MevinCheng
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Release EDM 4.2 Cl14.2.0.3 02/28/2014 Spider-80X/80Xi/80Hi/80Ci
Patch EDM 4.2.0 Cl4.2.0.14 | 07/02/2014 EDM Testing 11.0.0.x 11.0.0.1
Release EDM 5.0 Cl15.0.0.2 11/27/2014 Spider-81 (v7.x)
Patch EDM 5.0.1 Cl5.0.1.3 02/27/2015 EDM Testing 11.0.0.x 11.0.0.1
Release EDM 5.1 Cl5.1.0.6 08/12/2015 Spider-81B (v7.x)
Release EDM 6.0 C16.0.0.1 05/19/2016 EDM Testing 11.0.0.x 11.0.0.1
Patch EDM 6.0.2 C16.0.2.9 08/09/2016 Spider-80SG/SGi
Release EDM 6.1 C16.1.04 02/07/2017 EDM Testing 11.0.0.x 11.0.0.1
Patch EDM 6.1 C16.1.0.27 | 08/22/2017 Spider-20HE/20i
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Release EDM 8.0 C18.0.0.1 02/02/2019
Release EDM 8.1 C18.1.0.1 11/13/2019 CoCo-80X/90X
Release EDM 9.0 Cl9.0.0.4 06/05/2020 EDM Testing 11.0.0.x (EDM CoCo for DSA) 2.0.x B EE
Release EDM 9.1 C19.1.0.0 02/03/2021 CoCo-70X
Release EDM 10.0 C110.0.0.2 10/26/2021 EDM Testing 11.0.0.x (EDM CoCo for DSA) 2.0.x BEE
Release EDM 10.1 Cl 10.1.0.1 09/09/2022 Vibration Diagnostic System 1.4.2.x 2.0.x
Release EDM 11.0 C111.0.0.1 01/19/2023 CoCo-80
EDM 6.0.2.x 4.0
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Crystal Instruments Corporation Phone: +1 (408) 986-8880
2090 Duane  Avenue Fax: +1 (408) 834-7818
Santa Clara, CA 95054

www.crystalinstruments.com
Crystal Instruments Testing Lab info@go-ci.com
15661 Producer Lane, STE H
Huntington Beach, CA 92649

Crystal Instruments Testing Lab
1548A Roger Dale Carter Boulevard
Kannapolis, NC 28081

2023 Crystal Instruments Corporation. All Rights Reserved. 02/2023

Notice: This document is for informational purposes only and does
not set forth any warranty, expressed or implied, concerning any
equipment, equipment feature, or service offered or to be offered by
Crystal Instruments. Crystal Instruments reserves the right to make
changes to this document at any time, without notice, and assumes
no responsibility for its use. This informational document describes
features that may not be currently available. Contact a Crystal
Instruments sales representative for information on features and
productavailability.
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